
Portfolio Features

Portfolio 3.0 includes the following features:

Cross-platform functionality

Portfolio is the first truly cross-platform cataloging product available. This means that the same catalog file can be used 
simultaneously in Windows or on the Macintosh, with no conversion required. 

Translator support

Portfolio uses a translator system that allows it to read and display approximately 30 different image formats. This is particularly 
important for cross-platform use, where Windows applications cannot always use the thumbnail image and keywords many 
Macintosh applications store in their files.

Multi-user access

Portfolio uses a database engine designed to handle cross-platform data. Additionally, the database uses “record-level locking,” 
which lets multiple users add and edit items in a catalog simultaneously. 

Customizable views

You can specify which fields are displayed in a Gallery window, both in the Thumbnail and List views. This lets you easily view 
only the information that’s important to you.

In addition, you can alter the background color, text color, font, and thumbnail size of your Gallery windows, as well as rotate 
thumbnails so that you can view scanned images in their proper orientations.

Master Keyword List

In addition to item keywords, Portfolio includes a predefined list of keywords created by the catalog administrator called the 
Master Keyword List.    By restricting users to adding only keywords from this list to an item, administrators can guarantee that 
only accepted keywords are used within a catalog. The floating Master Keyword Palette lets users assign keywords to one or 
more items simply by dropping them onto item thumbnails.

Multiple security levels

Portfolio offers four levels of security, allowing catalog administrators to restrict access to specific catalog functions.

Custom fields

Traditionally, catalogs have been limited to a fixed number of information fields such as keywords and descriptions.    Portfolio 
lets you create an unlimited number of custom fields to provide context for your catalog information.    For example, if you create 
a Photographer field and a Location field, you can search the Location field for “Washington” without fear of finding photos taken
by a photographer named Washington.

Multiple catalogs

Portfolio can open any number of catalogs simultaneously, allowing you to quickly copy items from one catalog to another 
without losing keywords, descriptions and other vital information.

Gallery windows

Portfolio Galleries can contain any set of items, not just a set resulting from a search. Multiple Galleries can be open 
simultaneously, and you can add items to one Gallery by dragging them from another Gallery. Galleries can also be saved, which
allows distinct sets of items to be opened as a group; saved Galleries also retain custom formatting. 



Portfolio Concepts

Portfolio allows you to take images—graphics, presentations, multimedia and other digital media files—that you or members of 
your workgroup create and put them into a common catalog. You can then view, edit, copy, and retrieve the files from the catalog
and transfer them to other documents, regardless of file format, location, platform, or the applications that created the files.

Portfolio catalogs store thumbnail images rather than full document and images files, and create pointers to the original files. 
Because Portfolio does not store the files themselves, using a catalog is fast and efficient.

There is no limit to the number of items a single catalog can contain (bearing in mind that the more items in a catalog, the more 
memory and time are required for common operations). To each item in a catalog, you can add:

• An unlimited number of keywords that let you easily search a catalog.

• A description (up to 32,000 characters long) that lets you store important or useful information about the file.

• Data in custom fields.

In a workgroup setting, you can allow all users full access to all functions, or you can designate catalog administrators to create, 
maintain, and control access to catalogs for the entire workgroup. With    Portfolio installed on their computers, members of your 
workgroup can simultaneously search, view, and use items from catalogs whose source files are located on one or many 
network servers, shared volumes, CD-ROMs or removable drives.

Note: If you need to make your catalogs available to users who don’t have Portfolio, you may want to consider the Portfolio 
Content Publisher’s Toolkit and Portfolio read-only browser also available from Extensis. For details on this product, call (800) 
796-9798. 



Registering Portfolio

It is important to register your copy of Portfolio so that you are eligible for technical support, information regarding new versions, 
products, discounts and special offers on new products.

Portfolio includes electronic registration. To use electronic registration, you must have a modem connected to your computer. 
Portfolio will dial the number automatically, and the call is toll-free. If you do not have a modem, you can print the registration 
screen and register either by faxing it to (503) 274-0530 or mailing it in the postage-paid envelope provided. If you don’t have 
access to a printer, you can still register by filling out the registration sheet located at the end of the Portfolio manual. 

To register portfolio:

1. 1. The first time you launch Portfolio after installing it, a personalization dialog box appears. Enter your name, 
company and Portfolio registration number.

Your product registration number is located in the manual. If you choose not to personalize your copy, Portfolio will run in a 
60-day demonstration mode. A dialog box will remind you of how many days are remaining in the demonstration mode each 
time you launch Portfolio.

2. Once you have personalized Portfolio, a dialog box appears, asking if you would like to register. To register, click the 
Register Portfolio button; an electronic registration screen appears. 

3. After you’ve completed the registration screen, a Market Research screen and a System Configuration screen appear. 

The Market Research screen asks basic questions that enable us to better understand your needs. The System 
Configuration screen provides a “snapshot” of your system configuration that enables Extensis to support you more 
effectively. Sending this information is optional; if you do not wish to send it to Extensis, select the checkbox at the bottom of 
these screens. 



Getting Technical Support

For questions regarding Portfolio, please refer to the Portfolio manual first—it describes all of Portfolio’s features and basic 
operations. In addition, you can find frequently asked questions and troubleshooting tips on the Portfolio page of the Extensis 
World Wide Web site, at www.extensis.com.

If you have a problem that is not addressed in the manual or on the Extensis Web site, technical support is available at (503) 
274-7030, Monday through Friday 8:00 a.m. to 5:00 p.m. Pacific time.

Extensis provides free support to registered users on a limited basis, and extended support is also available.    For information on
extended support, please visit our Web site or call Extensis Technical Support at (503) 274-7030.



Cataloging Your Files

Once you’ve installed Portfolio, you can catalog one or more of your files.

To catalog your files:

1. Double-click the Portfolio icon.

A dialog box appears, prompting you to open an existing catalog or create a new one. Since you have not yet created a 
catalog, select “Create a new Portfolio catalog” and click “OK.” A directory dialog box appears.

Note: If you don’t have any files to catalog yet, you may want to select “Open an existing Portfolio catalog” instead, and 
open the sample catalog included with Portfolio. See Using the Sample Catalog for details.

2. Specify a name and location for your catalog, then click “Save.”

Portfolio creates a catalog file, which it stores on your hard drive. The catalog’s Gallery window opens.

3. Drag and drop selected files or folders into the catalog.

Select a file or folder from the Explorer and drag it into the Gallery window. When the window is highlighted, release the file or
folder. The “Catalog Properties” dialog box appears with the Options tab open.

4. Click “OK.”

The “Catalog Properties” dialog box lets you choose a variety of options when you catalog files. For this procedure, as for 
most files, the default settings should be fine. (For more information about adding and updating options, see Cataloging 
Option Basics.)

Next, the Cataloging Status window appears. This window shows the files as they are being added to the catalog. In this 
window, you’ll see a small picture (or thumbnail) of each file, as well as the number of files that were cataloged and their 
locations.

5. View your files.

You should now see all the files that you cataloged in the Gallery window. If you cataloged files that do not have thumbnails 
(such as text files), you will see a file icon instead of the thumbnail.

The items in the Gallery window are only references to the actual, or “source” files. The files themselves can be stored 
anywhere. However, to accomplish certain tasks in Portfolio you will need access to the source files.



Using the Sample Catalog

If you have not yet cataloged your own files, or if you’d like to work with other file types (such as multimedia files) that you may 
not yet have, you can use the Portfolio sample catalog. A Sample Catalog folder was placed in your Extensis Portfolio folder 
during installation. 

Note: The Sample Catalog folder contains the catalog, but not its associated files. Those files are located on the Extensis CD-
ROM from which you installed Portfolio.

To open the sample catalog:

1. Insert the Extensis CD-ROM into your CD drive.
2. Double-click the Sample Catalog icon in the Sample Catalog folder located in your Extensis Portfolio folder.

The sample catalog’s Gallery window appears.



The Portfolio Toolbar

Portfolio includes a toolbar on the application window. The toolbar puts many of Portfolio’s most commonly used features at the 
touch of a button, and gives you access to QuickFind, a fast way to find items in a catalog without opening the Find window.

You can leave the toolbar on the Portfolio application window, or you can “tear” it off as a free-floating palette.



Searching a Catalog

Use the Find window to tell Portfolio which catalog items you want to see. You can search any field, including custom fields (see 
Using Custom Fields for more information on custom fields).

You will probably find that you use different search strategies at different times. For example:

• If your catalog is small or you’re looking for ideas, you might start by looking through everything the catalog contains.

• If your catalog is very large or you have a general idea of what you’re looking for, you might want to look only at items 
related to a particular subject or concept, or of a particular file type.

• If you’re in the final stages of a job, you probably know exactly what items you need.

Portfolio displays the results of the search in a new Gallery window or in the current Gallery window, completely replacing the 
previous contents (if any).

To display the entire contents of a catalog:

• Choose “Find All” from the Catalog menu.

Or
• Click “Find All” in the Find window.

To find specific items in a catalog:

1. Choose “Find…” from the Catalog menu.

Portfolio opens the Find window and displays the default saved find.

2. Use the Find window to describe what you are looking for, then click “Find.”

Portfolio lets you search for various attributes of an item, including filename, keyword, file size and so on. 



Searching More Efficiently

Portfolio has several options that can help you search through a catalog quickly and effectively. For example, you can:

• Name and save frequently used searches (to save yourself from having to re-enter the descriptions each time). See Saving 
Finds.

• Customize the default search performed when you open a catalog. See Using the Default Find.

Searches performed on indexed fields are always faster because Portfolio uses indexes built into the database. When you 
search on indexed fields, choose “matches” from the modifier pop-up menu for the fastest searches, or “starts with” for 
searches that are almost as fast. 

Other types of searches may be a little slower because Portfolio must examine every entry in the catalog:

• Searching on file type or volume is slower when there is a large number of items that match what you are looking for.

• Searching on keyword or filename using “contains” or “ends with” can be slower when the catalog is large.

Volumes referenced in the catalog need not be mounted before you search.



Saving Finds

If you routinely use a particular set of items in a catalog, you can name and save a find that retrieves those items.

Your saved finds appear in the Saved Finds pop-up menu in the Find window. Whenever you want to use a saved find, choose 
its name from the menu.

To save a find:

1. Set up your search in the Find window.
2. Choose “Save As…” from the Saved Finds pop-up menu. 
3. Type a name for the new definition in the “Find Name” dialog box that appears.
4. Click “OK” to return to the Find window.

Portfolio stores the search definition you just created in the catalog.



Using the Default Find

You can edit the default find so that it retrieves the items you use most often. Portfolio carries out the default find the first time 
you open a catalog after starting the application or whenever you choose “Default” from the Saved Finds pop-up menu.

To change the default find:

1. Set up the search you want to use as the default in the Find window.
2. Choose “Save as Default” from the Saved Finds pop-up menu.

You can change the default find as often as you want.



Editing Saved Finds

You can change the criteria of your saved finds, rename them, duplicate them or delete them. You cannot rename or delete the 
default find.

To change the attributes of a saved find:

1. Choose the find you want to change from the Saved Finds pop-up menu.
2. Alter the search criteria and choose “Save” from the Saved Finds pop-up menu. 

The new search criteria is applied to the saved find.

To rename or delete a saved find:

1. Choose “Edit List…” from the Saved Finds pop-up menu in the Find window.

The “Saved Finds” dialog box appears.

2. Select the saved find you want to edit in the list. 
3. Click the appropriate button to rename, duplicate or delete the find.
4. Click “OK” to return to the Find window.

The changes are made to the saved find.



Gallery Window Basics

Portfolio displays catalog items in Gallery windows. You can see Gallery windows in Thumbnail view for visual browsing, or List 
view for text browsing (List view displays more information about the items).

In either view, you can scroll and select items to preview, print, edit, or use in other documents. You can customize Gallery 
window appearance for both Thumbnail and List views; see Customizing Gallery windows for details.

You can also save Gallery windows for future use once they contain the items you want. See Saving Gallery Windows..



Customizing Gallery Windows

You can change the layout of a Catalog’s Gallery windows. This allows you to display precisely the information you want in both 
the Thumbnail and List views, including information in custom fields.

To customize Gallery windows:

1. Choose “Customize…” from the View menu.

The “Customize Gallery” dialog box appears. Depending on the Gallery window’s current view, the Thumbnail or List tab is 
open.

2. Select the options you want.
3. Click “Apply” to apply the changes you made to the current view, without closing the “Customize View” dialog box.
4. Click “OK” to apply the changes you made and close the “Customize View” dialog box.

Note: Click “Save Defaults” if you want to save the current settings as the default layout. The layout is used for all new 
Galleries.



Saving Gallery Windows

Once a Gallery window contains the items you want in the layout you want, you can save the window for future use. For 
instance, you may want to create a Gallery of items to show to prospective clients.

To save a Gallery:

1. Make sure the Gallery window contains all the items you want, in the layout you want.

You can find items to add to the current Gallery window, or to create a new window; see Searching a Catalog for details. See 
Customizing Gallery Windows for information on changing Gallery window layouts.

2. Choose “Save Gallery…” from the Catalog menu.

The “Save Gallery” dialog box appears.

3. Type a name for the Gallery window and click “OK.”

The Gallery window is saved for later use.

Note: The name you specify for the Gallery does not appear at the top of the Gallery window. Instead, each Gallery for a 
catalog is numbered in the order in which it was created, and that number appears in the window’s title bar with the catalog 
name.

To open a saved Gallery:

1. Choose “List Galleries…” from the Catalog menu.

The “Saved Galleries” dialog box appears.

2. Select the Gallery you want to open in the list box, then click “Open.”

The Gallery window you selected opens. (You can also double-click a Gallery name to open it and automatically close the 
dialog box.)

3. Click “Done” to close the “Saved Galleries” dialog box.

To edit a saved Gallery:

1. Choose “List Galleries…” from the Catalog menu.

The “Saved Galleries” dialog box appears. 

2. Select the Gallery you want to edit.
3. Click “Rename…” to rename the selected Gallery, or click “Delete” to remove the saved Gallery from the catalog.
4. Click “Done” to close the “Saved Galleries” dialog box.



Previewing an Item

If you would like to look more closely at any image, you can open a Preview window for an item in Portfolio. This saves you from 
having to launch the application that the item’s source file was created in. You can have up to ten Preview windows open at a 
time.

Before displaying an item in a Preview window, Portfolio must be able to locate the item’s source file—that is, the original file 
from which the catalog entry was made. Portfolio alerts you when a source file cannot be located.

To preview an item:

• Double-click its thumbnail in the Gallery window.

Or
• Select the item, then choose “Preview Original…” from the Item menu.

Note: Some file types cannot be previewed. If Portfolio is unable to preview a file type, you are prompted to view the file in the 
application that created it. See Source File Basics for details.

The Preview window lets you display and manipulate an item in various ways depending on the item’s type.



Previewing Multimedia Files

Instead of opening a Preview window for movies, sounds and 3D images, Portfolio uses Windows’ built-in player applications for 
multimedia files. This applies to the following file types:

• .avi—Windows video files

• .mov—QuickTime movie files

• .snd—Macintosh sound files

• .aif—Apple AIFF sound files

• .wav—Windows sound files

• .mid—MIDI sound files



Source File Basics

Once you have identified a catalog item you want, you can work with it from within the open catalog. For example, you can:

• Switch to another program to edit the source file (the original file to which the catalog entry points). See Editing Source 
Files.

• Move, copy, or delete the source file. See Moving Source Files , Copying Source Files and Deleting Source Files.

• Copy the item to the Clipboard, switch to another program, and paste the item in a document. See Copying Source Files.

• Find out more information about the item.

• Print thumbnails or the item itself. See Printing Catalog Items.



Editing Source Files

You can edit item source files from within Portfolio.

To edit an item’s source file:

1. Select the item in the Gallery window, or open a Preview window for the item.
2. Choose    “Edit Original…” from the Item menu.

Portfolio remembers the name and location of the application last used to edit the source file for any item of the same type 
and creator. If necessary, you will be prompted to choose an application and to specify where the application is located.

Portfolio opens the application, which in turn opens the source file for editing.

3. Make the changes you want, save the file, and quit the application.

After quitting the editing application, you are returned to Portfolio.



Copying Source Files

You can copy item source files from within Portfolio.

To copy a source file:

1. Select the item and choose “Copy Original…” from the Item menu.
2. In the file directory dialog box, locate and open the folder where you want the copy to go.
3. Click “Save.” Portfolio copies the source file into the folder you specified.

Note: You can also copy source files by dragging them from Gallery windows onto the desktop or into folders.



Moving Source Files

Portfolio automatically updates the catalog after you move a file.

Note: “Move Original…” moves the source file from its current location to the one you specify. If the source file is locked, “Move 
Original…” does not move the file, but makes a copy of it in the new location.

To move a source file:

1. Select the item in the Gallery window.
2. Choose “Move Original…” from the Item menu.
3. In the file directory dialog box, locate and select the folder you want the original file moved to.
4. Click the “Select” button at the bottom of the directory dialog box.

Portfolio moves the source file into the folder you specified.



Deleting Source Files

You can delete item source files from within Portfolio.

To delete a source file:

1. Select the item in the Gallery window.
2. Choose “Delete Original…” from the Item menu.
3. Click “Cancel” if you change your mind or “OK” to go ahead and delete the file.



QuarkXPress 3.31 and Later

You can transfer cataloged images to your QuarkXPress documents.

To transfer images in Portfolio to QuarkXPress: 

1. From an open Portfolio catalog, select the image(s) you wish to drop into your QuarkXPress document.
2. Drag and drop the images into your open Quark document.

Each image is placed in a new picture box at the cursor location in the document.



Adobe PageMaker 6.5

You can transfer cataloged images to your PageMaker documents.

To transfer images in Portfolio to PageMaker 6.5:

1. Select the images in Portfolio.
2. Drag the images to your PageMaker document.



Adobe Illustrator 7.0

Illustrator automatically saves a thumbnail that Portfolio can display.



Macromedia FreeHand 7.0

You can save thumbnails and previews of your Freehand files for use in Portfolio.

To attach a thumbnail and preview in FreeHand:

1. Choose “Preferences…” from Freehand’s File menu.
2. Select “Importing/Exporting.”
3. Select “Include Fetch preview.”

When you save the file, a vector thumbnail and preview are created, increasing the size of your file. If your file has small 
dimensions, contains tiled fills, or is crowded with many objects, select “Bitmap Fetch preview size” to minimize the increase.



Dragging and Dropping Items

Portfolio lets you drag and drop items from Gallery windows into any application that supports OLE drag and drop. Check your 
applications’ documentation for information on OLE drag-and-drop support.

To drag and drop an item:

1. In Portfolio, select an item (or several items) in a Gallery window. 
2. Drag and drop the item(s) into an open document in the receiving application.

If the receiving application can accept the item’s file type, the item will be placed in the application.



Copying Items

Copying an item from Portfolio and pasting it into another application places the entire source file (or the selected portion of it) 
into the receiving document. You can use this method to transfer any catalog item to another application, whether that application
is “Portfolio aware” or not. The receiving document increases in file size by the size of the original file, or the selected portion of 
the file.

The file format of the items you copy may change when placed on the clipboard—for instance, copying an image from a Preview 
window copies the file as a Bitmap. The format change depends on the item’s original file type. If you need to preserve the 
image’s original format, you must manually import the image into the application.

To copy an item or part of an item:

1. In Portfolio, open the item’s Preview window and select the part of the item you want to copy.
2. Choose “Copy” from the Edit menu.
3. In the receiving application, choose “Paste” or “Paste Special” from the Edit menu.

Choosing “Paste Special” allows you to specify a file format for the item you are pasting.



Printing Catalog Items

Although you will typically find and select a catalog item either to edit the source file or use it in another document, you might 
want to print from the catalog itself—to show to a client, for example, or to evaluate items for possible use in a document.

When you choose “Print…” from the File menu, Portfolio prints the contents of the active window. To print thumbnails or a list of 
catalog items, print from the Gallery window. To print a single full-size image, print from a Preview window.

When you choose “Print…”, the resulting dialog box reflects the active window:

• If the active window is a Preview window, you see a standard “Print” dialog box that contains no special options for 
Portfolio.

• If the active window is a Gallery window, the print    dialog box includes the Portfolio options. 

Note: Printing options may vary with different printer drivers.



Specifying a Default Catalog

You can specify a default Portfolio catalog. The default catalog opens automatically when you first start Portfolio.

To specify a default catalog:

1. Open or create the catalog you want to use as the default.
2. Choose “Set Default Catalog” from the File menu.

A checkmark appears in front of the menu command. To deselect the catalog, just choose “Set Default Catalog” a second 
time or specify another catalog as the default.



Creating a New Catalog

New catalogs created from within Portfolio are empty. To add items, see Adding Items to a Catalog.

Note: Portfolio catalogs you create have an “.fdb” filename extension. Portfolio also creates a supporting file for each catalog; 
this file has an “.adm” extension, and cannot be opened on its own.

To create a new catalog:

1. Choose “New…” from the File menu.
2. Specify a name and location for the new catalog in the directory dialog box that opens, then click “Save.”

Portfolio creates the catalog and opens a blank Gallery window.

3. Add items to the catalog as described in Adding Items to a Catalog.



Adding Items to a Catalog

You can easily add items to a catalog from within Portfolio, or from the desktop or folders. In addition, you can update the catalog
after you’ve made changes to your files or moved or deleted files.

When using the “Add Items...” command from the Catalog menu, a directory dialog box appears allowing you to locate and 
select the files, folders, or volumes that you want to add to the open catalog.

When you add to a catalog, Portfolio displays the Options tab of the “Catalog Properties” dialog box so that you can change 
options before continuing. When you click “OK,” Portfolio adds the items and presents status screens so you can track the 
progress.

To add catalog items:

1. Launch Portfolio and open a catalog. 
2. Choose “Add Items…” from the Catalog menu, or select files directly and drag them into the Gallery window.

A directory dialog box appears if you chose “Add Items.…”

3. Locate the file, folder, or volume that you want to add. The volume that contains the files must be mounted.
4. If you used the “Add Items...” command, click “OK” in the directory dialog box.

The Options tab of the Catalog Properties dialog box appears.

5. Review and change any settings.

Choose an option from the “Modify Method” pop-up menu to specify how to add or update the files.

6. Click “OK.”

Portfolio scans the volume containing the source files, displays the “Cataloging Status” dialog box, and examines each file 
before adding it to the catalog.



Updating Items in a Catalog

You can easily add items to a catalog from within Portfolio, or from the desktop or folders. In addition, you can update the catalog
after you’ve made changes to your files or moved or deleted files.

To update catalog items:

1. Launch Portfolio and open a catalog. 
2. Choose “Update Items” from the Catalog menu, or select files directly and drag them into the Gallery window.

Portfolio searches for the source file of each item and updates it in the catalog. If a source file cannot be found, you are 
prompted to locate it manually.



Cataloging Option Basics

Unless you set your preferences otherwise, Portfolio displays the “Catalog Properties” dialog box whenever you add items to an 
open catalog by :

• Choosing “Add Items…” from the Catalog menu. See Adding Items to a Catalog.

• Dragging items into a Gallery window from the desktop or a folder.

If you prefer not to see this dialog box in these circumstances, choose “Preferences…” from the Edit menu, then deselect “Show
Options Dialog on Add/Update” in the “User Preferences” dialog box.



Excluding Files

As you build and modify catalogs, you can tell Portfolio to skip files of a certain type or name.

• If you want to skip files of a specific type, you can deselect or delete that file type in the file types list box located in the 
Options tab of the “Catalog Properties” dialog box. (For more information about file types and Portfolio, see Adding A File 
Type.)

• If you want to skip files with a specific file name, you can create an exclusions list.

You create an exclusions list by specifying an explicit set of file names. This list is stored in the catalog.

To add items to the exclusions list:

1. Choose “Catalog Properties…” from the Catalog menu.

The “Catalog Properties” dialog box appears with the General tab open.

2. Open the Exclude tab.

To add an entry, type the filename you want into the text box, then click “Add.” Letter case is irrelevant. Portfolio searches 
each pathname for the text string you enter. For example, if you enter “ext,” Portfolio excludes the file “EXTRA.GIF” as well 
as “extensis_logo.eps.” Likewise, all files in the “Extreme” folder will be excluded.

To delete an entry, select it in the list box, then click “Delete.”

3. When you have made all the changes you want, click “OK” to save the exclusions list.



Adding a File Type

When you add items to a catalog, you’ll notice that the Options tab of the “Catalog Properties” dialog box lists the types of files 
Portfolio recognizes. While you can easily modify this list, it’s important to remember that Portfolio can recognize and catalog 
any file type, whether it’s in the list or not. It’s simply a matter of selecting the “Catalog All Types” option button above the list 
when adding items.

Still, there may be times when you want to add file types to this list, or remove file types from it altogether. For example, you 
might want to add the file type for an application you use frequently, but whose file type is not currently supported. 

Depending on the file types of the items you add, Portfolio either generates a thumbnail for the item, extract a thumbnail from its 
source file, or display a file icon rather than a thumbnail. 

To modify the list of file types:

1. Choose “Catalog Properties…” from the Catalog menu.

The “Catalog Properties” dialog box appears.

2. Select the Options tab.

To add a file type, click “Add…”; the “File Type” dialog box appears. In the Extension text box, type the three-letter file 
extension for the file type you are adding. In the Description text box, type a description. Select “Store in Catalog” if you want
the file type to be added to the list stored with the Catalog file (so others can use the settings). Select “Store in Preferences” 
if you want the file type to be added to the list stored in the Portfolio Preferences file. When all settings are correct, click 
“OK.”
To edit a file type’s settings, select it in the file type list box, then click “Edit…”; the “File Type” dialog box appears. Change 
the settings you want, then click “OK.”
To remove a file type, select it in the file type list box, then click “Delete.” File types that you delete are removed from the list 
altogether; if you just want a file type to not be added to your catalog, deselect the checkbox in front of its name.

3. Click “OK” to close the dialog box and save the revised list.



Keyword Basics

Each item in a catalog has certain information associated with it, such as filename, file type, volume, and so on. Each item can 
also have one or more keywords associated with it. A keyword is a word or phrase that you associate with a particular item, and 
a good keyword list can be a valuable tool for finding the information you need in a catalog.

In addition, a catalog can include a preset list of Master Keywords. Master Keywords can help maintain consistent keywords 
among the items in a catalog, or across catalogs. See Entering and Editing Master Keywords for details.

Each item can have an unlimited list of keywords associated with it. In a network environment, a catalog administrator can 
control who edits keyword lists for each catalog (see Setting Catalog Passwords for details).



Viewing Keywords

You can view keywords and Master Keywords in several ways:

• In the Master Keywords Palette

• In the Item Properties dialog box

• In the Catalog Properties dialog box

To display the keywords for an item:

1. Select the item, then choose “Item Properties…” from the Item menu. 

The “Item Properties” dialog box appears.

2. Select the Keywords tab.

The item’s keywords appear in a list box on the right. Master Keywords appear on the left.

3. Click “OK” when you finish viewing the keywords.

To display the keywords for an entire catalog:

1. Choose “Catalog Properties…” from the Catalog menu. 

The “Catalog Properties” dialog box appears.

2. Select the Statistics tab.
3. Click “Calculate….”

The keywords for all items in the catalog appear in the list box on the left.

Note: You can export the catalog’s item keywords to a text file by clicking “Export Keywords….” This is useful if you want to 
import those keywords into the catalog’s Master Keywords list.



Entering and Editing Keywords

You can enter and edit keywords. You can also enter Master Keywords, provided you have administrative privileges—see 
Entering and Editing Master Keywords for details.

To enter keywords:

1. Select the item to which you want to add keywords, then choose “Item Properties…” from the Item menu.

The “Item Properties” dialog box appears.

2. Select the Keywords tab.
3. Type a keyword in the text box, then click “Add.”

The keyword is added to the Keywords list.

Note: If the catalog administrator has restricted keyword addition to only those in the Master Keyword list, Portfolio checks 
your additions against the list and notifies you of any “illegal” keywords. See Entering and Editing Master Keywords.

4. Continue adding keywords, then click “OK.”

You can use the “Edit Keywords…” dialog box to edit item keywords. For instance, if you ever need to remove a keyword from 
more than one item, you can do so in one swift action rather than individually.

To edit a keyword list:

1. Select the item(s) for which you want to edit keywords, then choose “Edit Keywords…” from the Item menu.

The “Edit Keywords” dialog box appears.

To add a keyword, type a keyword in the text box, then click “Add.” The keyword is added to the keyword list when you click 
“OK.”

To assign a keyword, select the keyword in the list, then click “Assign.” The keyword is assigned to any selected items that it 
was not previously assigned to.

To delete a keyword, select a keyword in the Keyword list box, then click “Delete.” The keyword is removed from the list and 
any selected items when you click “OK.”

2. Click “OK” to save the changes to the item’s keywords list.

To abandon the changes you made to the keywords, click “Cancel.”

Note: You can select more than one keyword at a time for deletion, and you can add as many keywords as you want before 
clicking “OK.”



Description Basics

In addition to adding keywords to any item, you can add adescription up to 32,000 characters long. You can use the description 
field to keep track of any information about the source file that you might find useful or important. For example, the description for
a photo image could include notes about who took the original photograph, copyright, and agency or contact information.

You can add or edit a description after cataloging. In a network environment, acatalog administrator can control who edits 
descriptions. 

See Entering and Editing Descriptions for details.



Entering and Editing Descriptions

You can enter and edit descriptions. 

To enter or edit a description manually:

1. Select the item to which you want to add a description, then choose “Item Properties…” from the Item menu.

The “Item Properties” dialog box appears with the General tab selected.

2. Type a description in the Description text box, then click “OK.”

The description is added to the item.

Note: If the Description text box is unavailable, you do not have permission to edit descriptions for items in the open catalog. 
If you are working in a network environment, check with your catalog administrator.



Using Custom Fields

If custom fields have been defined for a catalog, you can change their values (or contents). For example, you can add 
photographers’ names to the “Photographer” field in a catalog of photographic images. Some custom fields even allow more 
than one entry, so you could enter the number of times an image has been published in a single field.

Note: You must have Editor access or above to a catalog in order to change its custom field values. To define new custom fields, 
you require Administrator access. See Catalog Access Levels and Adding Custom Fields for complete details.

To use custom fields:

1. Select an item in a Gallery window and choose “Item Properties…” from the Item menu.

The “Item Properties” dialog box appears with the General tab open.

2. Open the Fields tab.

All custom fields for the catalog appear in the list box.

3. Select the field you want to change, then click “Edit….” 

The “Edit” dialog box for the field type appears.

4. Type the appropriate value in the text box and click “OK.”

If you enter a value that is incorrect for the field type, clicking “OK” produces no result. You must re-enter the proper value 
type.

5. Click “OK” to close the “Item Properties” dialog box.



Replacing Keywords and Custom Field Values

You can easily replace keywords and custom field values in your Portfolio catalogs. For example, if you need to modify a 
keyword for several items in a catalog, you can do so automatically. Similarly, if the print date for a collection of images slips by a
week, you can replace the incorrect date in the “Publish Date” field for all the images in the catalog at once.

To replace keywords and custom field values:

1. Choose “Replace…” from the Catalog menu.

The “Find and Replace” dialog box appears.

2. Select the keyword or field to search in the “Fields to Search” pop-up menu.

The pop-up menu lists all of the custom fields defined for the catalog, as well as a keywords option.

3. Enter the keyword or value you want to replace in the “Find” text box.

If you are replacing a custom field value, be sure to enter an appropriate value for the field you selected in step 2.

Note: If you are replacing keywords in a multi-user catalog, the catalog must allow keyword addition or no action is taken. 
Check with the catalog administrator or see Entering and Editing Master Keywords for more information.

4. Enter the replacement keyword or value in the “Replace With” text box.
5. Select the appropriate option button for your search.

You can search only the selected items in the Gallery or the entire Gallery.

6. Click “OK.”

Portfolio searches for and replaces all instances of the keyword or custom field value you specified. A dialog box appears 
informing you of the number of replacements performed.



Catalog Maintenance Basics

Catalogs—especially large ones—that are heavily used and frequently updated can become out-of-date. In addition to routinely 
backing up all catalogs and source files (and keeping the backups in a safe place), it is a good idea to perform other 
housecleaning tasks regularly as well. Portfolio provides the catalog manager or administrator with tools that can help with 
routine catalog maintenance.



Exporting Catalogs as Text Files

The “Export…” command in the File menu lets you save a text representation of catalog items. Exporting is a useful way of 
keeping track of the items in a catalog outside of Portfolio.

To export a catalog as a text file:

1. Select the items you want to export.
2. Choose “Export…” from the File menu.

A directory dialog box appears.

3. Specify a name and location for the export file, then click “Export.”

The catalog is exported to the text file you specified.



Removing Items from a Catalog

The “Delete Items…” command lets you clear a catalog of unwanted or out-of-date items or references.

To remove specific items from a catalog:

1. Select the items you want to delete in the Gallery window.
2. Choose “Delete Items…” from the Catalog menu.

The “Delete Items” dialog box appears.

3. Select “Delete from Catalog” and click “OK.”

Note: Select “Delete from Gallery” if you want to remove the item from the Gallery window only. The item remains in the 
catalog when you click “OK.”



Checking for Missing Files

You can easily determine if any file references in a Portfolio catalog are no longer valid.

Note: Portfolio only searches for missing files on mounted volumes. If a volume containing item source files is not mounted, 
Portfolio will not detect the files.

To check for missing files:

1. Open the catalog.
2. Choose “Missing Files…” from the Catalog menu.

Portfolio checks the catalog and lists all missing files in the “Missing Files” dialog box. 

3. Select the files you want to update and click “Update….”

You can also delete files you no longer want in the catalog by selecting them and clicking “Delete.”



Recovering Damaged Catalogs

You may be able to recover Portfolio catalogs that you have trouble opening and suspect may have been damaged.

To recover a catalog:

1. Choose “Recover…” from the File menu.

A directory dialog box appears.

2. Locate the catalog you want to recover and click “Open.”

A second directory dialog box appears.

3. Type a new name for the recovered catalog, select where you want to save it and click “Save.”

A dialog appears as Portfolio checks the catalog and performs any necessary repairs. When the recovery is complete, a 
recovery report dialog box appears to provide details of the items that were and were not recovered.

4. Click “OK.”

When the recovery is finished, open the recovered catalog to make sure that all its items are intact.



Catalog Access Levels

A Portfolio catalog is protected if a password is required to use it. There are four access levels that can be established for a 
catalog: Administrator, Publisher, Editor and Reader. Each level can have its own password.

The Administrator level is usually assigned to the catalog creator alone. This level allows access to all catalog functions, 
including creating and editing custom fields. The Administrator is responsible for setting all access level passwords, and is the 
only user who can change the passwords. In addition, the Administrator is the only user who can create or modify a catalog’s 
Master Keyword list, as well as specify whether other users can add their own keywords to the catalog.

Note: A shared catalog cannot be accessed by other users when it is in use by its Administrator. Consequently, you cannot 
switch to Administrator level if other users also have the catalog open.

Portfolio access levels are inherited; that is, the Administrator level includes the privileges of all other levels (in addition to its 
other privileges), the Publisher level includes the privileges of the Editor and Reader levels, and so on.



Setting Catalog Passwords

Multiple users can use a catalog simultaneously across a network, within the restrictions of their access privileges. Therefore, 
password protection is strongly recommended when a catalog is available to multiple users. Protection is, however, not 
necessary if you are the single user of a catalog on your own computer.

You can set passwords when you first create a catalog, or if you have Administrator privileges for another catalog.

To set or change catalog passwords:

1. Open the catalog.
2. Choose “Administration…” from the Catalog menu.

The Catalog Administration dialog box appears with the Master Keywords tab open.

3. Open the Passwords tab.
4. Click “Set Password…” in the “Administrator” field.

The “Set Password” dialog box appears.

5. Type the new password in each text box, then click “OK.”

You enter the new password a second time to verify that it is correct. Passwords must be between 4 and 12 characters in 
length.

6. Repeat steps 4 and 5 for the other passwords you want to set (Publisher, Editor or Reader).

Note: Even if you only set a Reader password, users logging in as Editor or Publisher will need that Reader password to gain 
access to the catalog.

7. Click “OK” to close the Catalog Administration dialog box and save the new password(s).
8. Close the catalog and reopen it to put the password(s) into effect.

Once a catalog is password-protected, a passwords dialog box appears when the catalog is opened. Users can then choose 
their access level from the Access Mode pop-up menu, enter the correct password and click “OK” to open the catalog.

Note: You can specify a catalog’s default access level in the General tab of the “User Preferences” dialog box. 



Entering and Editing Master Keywords

Establishing a Master Keyword list for a catalog can help you maintain consistent keywords among the items in the catalog, or 
across catalogs With a Master Keyword list, you can ensure that only the keywords in the list are used in the catalog.

You can enter Master Keywords manually, or you can import them from an existing text file.

Note: Master Keywords are not dynamic. That is, when you change or delete a Master Keyword in the “Catalog Administration” 
dialog box, that Master Keyword is not automatically changed in any items to which it’s been applied.

To enter and edit Master Keywords:

1. Choose “Administration…” from the Catalog menu.

The “Catalog Administration” dialog box appears with the Master Keywords tab open.

2. To add a Master Keyword, type a keyword in the text box, then click “Add.”

The keyword is added to the Master Keywords list.

3. To delete a Master Keyword, select a Master Keyword in the list box, then click “Delete.”

The keyword is only removed from the list, not from items to which it is applied.

4. To rename a Master Keyword, select a keyword in the list, click “Rename,” and type a new name for the keyword.

The keyword is only renamed in the list, not in items to which it is applied.

5. To import Master Keywords, click “Import.” Locate and select the text file containing the Master Keyword list to import
in the directory dialog box, then click “Import.”

The keywords in the file are added to the catalog’s Master Keywords list.

6. To export Master Keywords, click “Export.” Specify a filename and location for the exported Master Keyword    list in 
the directory dialog box that appears, then click “Export.”

The file is exported as a text file with carriage returns separating each keyword, and is available for use in other Portfolio 
catalogs.

7. To restrict keyword entry, select “Restrict Keywords to Master List.”

Users can only select keywords from the Master Keyword list for catalog items.

8. Click “OK” to close the “Catalog Administration” dialog box.



Custom Field Basics

Portfolio catalog databases consist of a number of predefined fields. These system fields, such as Filename, Path, Created and 
so on, categorize the file information for each item in a catalog, allowing you to search for specific items based on that 
information.

In addition to the system fields, you can define custom fields to hold specialized information about catalog items. For instance, 
you might want to add a field for Web site URLs to a catalog of GIF files, or a “Photographer” field to a catalog of photographic 
images. See Adding Custom Fields.

There are four custom field types from which you can choose:

• Date/Time, for date and/or time values. You could use this field type to create a custom field for image publication dates.

• Decimal, for decimal point numeric values. This field type would be useful for custom fields containing stock image prices.

• Number, for regular numeric values. This field type is ideal for custom fields containing catalog part or stock numbers.

• String, for text values. This field type can be used for any number of custom fields, including photographer or artist names.



Adding Custom Fields

You can add custom fields to a catalog.

Note: You must have Administrator access to a catalog in order to add custom fields. Users with Editor access privileges and 
above can edit custom field values.

To add custom fields to a catalog:

1. Choose “Administration…” from the Catalog menu.

The “Catalog Administration” dialog box appears with the Master Keywords tab open.

2. Open the Custom Fields tab.
3. Click “Add….”

The “Custom Field Definition” dialog box appears.

4. Type a name for the field in the “Name:” text box.
5. Choose the field type from the “Type:” pop-up menu.

The field type determines the values that can be entered into this field. Field types cannot be changed once they are defined.

6. If you chose “String” in step 5, specify the maximum number of characters allowable in the field in the “Length” text 
box. If you chose “Decimal,” specify how many places are allowable after the decimal point.

7. Select the appropriate remaining options in the dialog box.

To make the field sortable, select “Indexed.” The field is added to the list of sortable fields that appears when you choose “by
Other…” from the View menu. Searching is also fasteron indexed fields.

To allow multiple field entries, select “Multiple Values.” Different users can specify their own values for this field in a multi-
user catalog. This is useful if, for example, a user wants to list all instances of an image’s publication in a single field.

8. Click “OK” to define the custom field.
9. Click “OK” to close the “Catalog Administration” dialog box.



Using Portfolio on a Network

A single Portfolio catalog can contain references to source files on multiple hard disks, network servers, CD-ROM discs, or 
removable disks, whether these media are mounted or not. When Portfolio needs to retrieve a source file that resides on a 
network volume, it automatically mounts that volume, prompting for a volume password when required.

If a source file is stored on removable media, such as floppy disks or CD-ROMs, Portfolio prompts for the disk by name. Portfolio
also prompts for source files that have been moved or renamed.

In a network environment, a shared catalog can be on a network file server or on any one user’s PC, if the PC is properly 
networked.



Network Environment Concerns

In a typical network scenario, many users would open Portfolio, locate items they want, and leave Portfolio running in the 
background while they switch to other applications to edit source files, work on other documents, read e-mail, and so forth. 
Meanwhile, at any given time, only some of those users would be actively using the catalog to search for and preview items they 
might be interested in, while fewer still might be adding or updating items, keywords, or descriptions.

The greater the number of users who have a catalog open, the slower individual searches will be, depending on what tasks the 
users are performing in Portfolio. The speed of the network and the server can also affect the performance of Portfolio.

If a user’s system crashes or is shut down while the user has a shared catalog open, Portfolio will examine the catalog for 
damage and temporarily make other users wait until the verification is complete. Therefore, users should always close and quit 
to exit a catalog rather than shut off or restart their systems.

If you want to limit who can write to or read from a catalog, you can set passwords as described in Catalog Access Levels. 
Whether or not your catalog is password-protected, it is essential that you also set up the network access conditions described in
the table below.



Managing Source Files

There are many ways to organize the source files for items in a Portfolio catalog. Each strategy has advantages and 
disadvantages, but considering the options and planning ahead can save you time in the long run and significantly increase the 
usefulness of Portfolio to you and your workgroup.

One of the key benefits of using Portfolio is that you do not need to remember where a source file is located or what it is called. 
However, because Portfolio can use filenames, folder names, or entire pathnames as keywords, and because you can then use 
those keywords to help in searching, a rational plan for naming and organizing files and folders is helpful.

Each workgroup must ultimately decide what works best for its own situation based on how the group works and how work flows 
through it. Here are a few suggestions that might help in your planning.



Organizing Source Files

One of the most obvious ways to organize files into folders is to set up a series of folders for each project, client, or category (for 
example, travel, business or architecture). Within a folder, use subfolders to partition related files appropriately.

Another approach is to organize files into folders by file type, by parent application, or by department of origin (for example, 
Marketing, Sales or Publications).

Once you’ve organized your files into folders, it’s easy to include the files into Portfolio catalogs.



Naming Source Files

Use naming and organizing strategies together to make the most of keyword searching in Portfolio. Once you have decided how 
to organize your files, consider the following alternatives for naming them:

• Use file extensions to indicate file type. This is very important when using Portfolio in a cross-platform environment, where 
you’ll want to keep Windows file naming restrictions in mind when naming Macintosh files.

• Use number or alphabetic prefixes to help sort items in ways that matter for the kinds of files you use. For example, you 
might use frame numbers for images from a single photo shoot or counter or time code readings for sounds, movies, or 
images digitized from video or audio tape.



Menu Command Hotkeys

The following menu command hotkeys assist you in performing common Portfolio tasks.

To… Use this hotkey…

Create a new catalog Ctrl+N

Open an existing catalog Ctrl+O

Print a Gallery Ctrl+P

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Select all items in a catalog Ctrl+A

Open/close the Master Keywords palette Ctrl+K

View Gallery in Thumbnail view Ctrl+T

View Gallery in List view Ctrl+L

Find specific items in a catalog Ctrl+F

Find all items in a catalog Ctrl+'

Add items to a catalog Ctrl+E

Update items in a catalog Ctrl+U

View catalog properties Ctrl+J

View item properties Alt+Enter

Preview an item's source file Ctrl+B

Edit an item's source file Ctrl+M
(with last selected editing application)

Edit an item's source file Ctrl+Shift+M
(with a new editing application)

Create a new Gallery Ctrl+G

Close a catalog Ctrl+W

Customize a Gallery Ctrl+D

Save a Gallery Ctrl+S

List all saved Galleries Ctrl+Q

Rotate a thumbnail 90° clockwise Ctrl+]

Rotate a thumbnail 90° counter-clockwise Ctrl+[

Quit Portfolio Alt+F4

Refresh a Gallery window Ctrl+R

Edit item keywords Ctrl+Y

Perform catalog administration tasks Ctrl+H



Navigational Shortcuts

The following keyboard shortcuts assist you in Portfolio navigation.

To… Press this… Notes

Move one item to the right in a Gallery window Right-arrow key Thumbnail view only

Move one item to the left in a Gallery window Left-arrow key Thumbnail view only

Move one item down in a Gallery window Down-arrow key

Move one item up in a Gallery window Up-arrow key

Scroll down one screen in a Gallery window Page Down

Scroll up one screen in a Gallery window Page Up

Go to the top of a Gallery window Ctrl+Home

Go to the bottom of a Gallery window Ctrl+End

Go to the first item in a Gallery window row Home Thumbnail view only

Go to the last item in a Gallery window row End Thumbnail view only



Functional Shortcuts

The following keyboard shortcuts assist you in performing common Portfolio tasks.

To… Do this…

Preview an item Double-click the item in either Gallery window view
Double-click the item thumbnail in List view
Double-click the item thumbnail in the "Item Properties" dialog box

Edit an item's source file Ctrl+double-click the item in either Gallery window view
Ctrl+double-click the item thumbnail in List view
Ctrl+double-click the item thumbnail in the "Item Properties" dialog box

Search for items based on a keyword Double-click the keyword in List view
Double-click the keyword in the "Item Properties" dialog box
Double-click the keyword in the "Catalog Properties" dialog box
Double-click the keyword in the Master Keywords Palette

Remove an item from a Gallery window Select the item and press Delete

Remove an item from a catalog Select the item and press Ctrl+Delete




